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Introduction

Overview

This manual describes the new ABC FDC system. Project Foobar is the main reason for revising the old ABC FDC system. The structures in new system have been designed to allow ABC’s business to be analysed by Operation (Rail, Highways etc), Market (Public, Private etc) and Ledger/Legal Entity. The schedules have been designed to integrate with the p&l layout of the new SAP system.

Major changes

Analysing ABC's business by operation, market and ledger/legal entity means data will have to be input at contract group level, at present data is mainly input at ledger/legal entity level. The system has been designed to cope with this transition. The timetable and objectives of the transition from ledger/legal entity to contract group reporting are described below.

Timetable

Date/Deadline
Tasks

[ ] Sep 2001
Install ABC FDC system.
Send actuals for Jul 2001 using ABC FDC system.

Aug 2001 Month End
Send actuals for Aug 2001 using ABC FDC system.

Nov 2001 Month End
Send actuals for all reporting units to head office.

Actuals for 2001

Initially actuals can be submitted for legal entities as they are at present. However, by November 2001 month end p&l data should be submitted for all contract groups. Where the supporting ledger allows balance sheet data should also be submitted for all contract groups. If the supporting ledger cannot analyse assets by contract groups then the balance sheet should be input into a separate FDC unit. See the Organisation structures section for a definition of contract groups.

Actuals for 2002 onwards

As in 2001 p&l data should be submitted for all contract groups. ABC's aim is that balance sheets should be prepared for all contract groups. However, this is dependent on the capability of the underlying ledger. Until balance sheet data can be submitted for each contract group the balance sheet for a ledger should be input into a separate FDC unit.

Budget for 2002

Profit and loss budgets must be prepared for all contract groups. Balance sheets should be prepared at the same level as actual data will be submitted at in 2002. That is if contract group balance sheets will be submitted in 2002 then contract group balance sheet budget should be prepared for 2002.

Software

The ABC FDC system is based on Comshare FDC v5.0.1.3 a popular consolidation package.

Organisation structures

Overview

One of the objectives of Project Darwin is to allow ABC's business to be analysed by:

· Operation - Clusters, Rail, Highways etc.

· Market - Public, Private etc.

· Ledger/Legal Entity

This would have been difficult using the structures in the old system as data was input at ledger/legal entity level. Therefore in the new ABC FDC system data is input at a lower level.

Reporting units

In Comshare FDC data is input into reporting units which are the lowest level in organisation structures. In the new ABC FDC system reporting units can be:

· Contracts or groups of contracts;

· Costs centres or groups of cost centres; or

· Balance sheets

To ensure data integrity every reporting unit must balance. Sometimes the data for a reporting unit will not balance e.g. because it is a cost centre and does not have a separate balance sheet. When this happens a dummy entry on the Creditors inter contract line on the balance sheet is used to balance the unit. A corresponding contra entry must be made on the related balance sheet.

Contract and cost centre units

Where a reporting unit is a group of contracts or cost centres all the contracts/cost centres in the group must be in the same Operations Cluster and Market Sector. Balance sheet information can be input into these reporting units.

Balance sheet units

Where a unit is a balance sheet and relates to several contracts or costs centres it must not have profit and loss data. This is because while contracts and costs centres can be allocated to different operations clusters and markets sectors common balance sheet cannot as they may relate to different operations and markets. They must therefore be allocated to group and any associated p&l data would also be allocated to group distorting the Operations and Markets analysis.

Structures

This section describes the three structures in the ABC FDC system.

Ledger/legal entity structure

This structure groups reporting units (contract groups) into the general ledgers they are accounted for in. This structure is important for data entry, as the Creditors inter contract line for all the units in a general ledger must net to zero. A simplified structure is shown below.

Unit


Description

4000


ABC Group Ledger


4010

General Ledger 1 (e.g. [])



3010
3020
3030
3040
3050
3060
Contract Group 1 (e.g. [])
Contract Group 2
Contract Group 3
Contract Group 4
Balance Sheet 1
Overheads Ledger 1


4020

General Ledger 2 (e.g. [])



3110
3120
3130
3140
3150
3160
Contract Group 5 (e.g. [])
Contract Group 6
Contract Group 7
Contract Group 8
Balance Sheet 2
Overheads Ledger 2

Operations Structure

This structure is used to group reporting unit (contract groups) into their Darwin management clusters. A simplified structure is shown below.

Unit


Description

5000


ABC Group Operations


5010

Cluster 1



3010
3020
3110
3120
Contract Group 1
Contract Group 2
Contract Group 5
Contract Group 6


5020

Cluster 1



3030
3040
3130
3140
Contract Group 3
Contract Group 4
Contract Group 7
Contract Group 8


5030

Overheads



3050
3060
3150
3160
Balance Sheet 1
Overheads Ledger 1
Balance Sheet 2
Overheads Ledger 2

Market Structure

This structure is used to group reporting unit (contract groups) into their Markets. A simplified structure is shown below.

Unit


Description

6000


ABC Group Markets


6010

Public Sector



3010
3020
3130
3140
Contract Group 1
Contract Group 2
Contract Group 7
Contract Group 8


6020

Private Sector



3030
3040
3110
3120
Contract Group 3
Contract Group 4
Contract Group 5
Contract Group 6


6030

Overheads



3050
3060
3150
3160
Balance Sheet 1
Overheads Ledger 1
Balance Sheet 2
Overheads Ledger 2

Provisional structures

Provisional structures showing the FDC units for each ledger/legal entity have been created in ABC FDC system. The easiest way to reviews these structures is to open C:\FinApp\Data\FDCUser\Structure.xls. If this file was not included in the same CD or email as this document please contract Guy Phillips for a copy. If you need changes made to these structures please contact Guy Phillips.

Unit Number Ranges

Generally unit numbers will be in the following ranges. There may be exceptions to this e.g. where a sub structure is identical in the Legal, Organisation and Market structures.

Range
Description

0-3999
Contract group cost centre group and balance sheet reporting Units

4000-4999
Ledger structure consolidation units

5000-5999
Operations structure consolidation units

6000-6999
Market structure consolidation units

Schedules

Overview

The schedule layouts in the ABC FDC system are based on the 2001 Budget spreadsheet and have been designed to integrate with the p&l layout of the new SAP system. The schedules are listed below.

Id
Description
Required

V1099
Profit and Loss (Share JVs)
Conditional

V1210
Profit and Loss Inter Company Detail
No

V1220
Profit and Loss Sale of Group Companies
Conditional

V1299
Profit and Loss
Conditional

V2210
Balance Sheet Intercompany Detail
No

V2220
Balance Sheet Movements
Conditional

V2299
Balance Sheet
Yes

V3299
Cash Flow
N/A

V = Version (B – Budget or M – Man Actuals)

Required schedules must be input for every unit. However, not every unit will have a balance sheet. For these units a contra entry for Retained Profits will be made on the Creditors inter contract line. This will be balanced by an opposite entry in the balance sheet that related to the unit.

Formula

These schedules are linked by schedule and generate number formula, which are similar to the formula in Excel. The table below shows how the schedules are linked.

1
2
3
4

Schedule Title

V3299




Cash Flow

G
V1299



Profit And Loss

G
V2220



Balance Sheet Movements

G
V2299



Balance Sheet


S
V2220


Balance Sheet Movements



S
V1299

Profit and Loss




S
V1220
Profit and Loss Sale of Group Companies




S
V1210
Profit and Loss Intercompany Detail


S
V2210


Balance Sheet Intercompany Detail

S = Schedule Formula
G = Generate Numbers Formula
V = Version (B – Budget or M – Man Actuals)

Schedule formula

Number
Description

100-149
Profit and loss cross check formula

150-199
Profit and loss generate formula

200-249
Balance sheet cross check formula

250-299
Balance sheet generate formula

300-349
Cash flow cross check formula

350-500
Cash flow generate formula

Cross checks

Cross checks ensure that:

· Schedules are consistent

· Balance sheets balance

· The notional Creditors inter contract line nets to zero for each legal/ledger entity.

Submitting actuals

Overview

The main tasks to submit actual data to head office are:

1. Input data

2. Cross check data

3. Create transmission file

4. Email transmission file

These tasks are described below.

Input data

The steps to input actual data into Comshare FDC are:

1. Start Excel Consolidation Site. From the Windows Start menu select Programs | Comshare FDC | Excel Consolidation Site. This will be Excel Control Site if you are at head office or Excel Reporting Site if you have reporting software.

2. Log in to Comshare FDC. At consolidation and reporting sites the user id is Comshare and the password is FDC.

3. Open the first template. In Excel on the Data Entry menu select Enter Data…. Select the template from the Open dialog and click OK. See below for details of the templates.

4. Select the unit, period and year and click OK. You have to select all the items, unit, period etc. in the left-hand box before you can click OK.

5. Input your data into the template as you would into any Excel workbook. Freezing panes will probably make this easier.

6. Save the data. From the File menu select Close. In the Data Entry dialog check Submit these values before closing this view and click OK.

7. Repeat steps 1 to 6 until you have input all the templates.

Input order

In Comshare FDC the order schedules are input in is important. This is because schedules are linked using schedule formula, which are similar to formula in Excel. For example in the revenue reserve movements on M2220 Balance Sheet Movements the Retained profit line is linked to schedule M1299 Profit and Loss. This means M1299 must be input before M2220.

To make the system easier to use it has been designed so that schedules are input in the order they are numbered e.g. M1299 Profit and Loss is input before M2220 Balance Sheet Movements.

Actual templates

Template
Description

L-M1299 Profit and Loss
L-M2220 Balance Sheet Movements
L-M2299 Balance Sheet
The L prefix indicates these templates input data to all the units of a Ledger/Legal Entity. They have one column per unit in the ledger. They should make data entry quicker and make it easier to balance the Creditors inter contract line.

U-M1099 Profit and Loss (Share JVs)
U-M1220 Profit and Loss Sale of Group Companies
U-M1299 Profit and Loss
U-M2220 Balance Sheet Movements
U-M2299 Balance Sheet
U-M3210 Cash Flow Adjustments
The U prefix indicates these templates input data to individual reporting units. They will be useful if you need to input data into a single unit or into a schedule which does not have an L view.

Cross check data

Once data for a ledger has been input it must be cross check before it can be transmitted to group. The steps to do this are.

1. Display the Batches dialog. In Excel Consolidation Site on the Prepare menu select Batches….

2. Select the Cross check (Actuals) batch.

3. Select the appropriate unit, period and year.

4. Click OK to run the batch.

Any errors in the data are stored in C:\FinApp\Data\FDCUser\XCheck01.rpt, which is displayed automatically.

Create transmission file

Once you have cross check your data and manually reviewed it you can create a transmission file to send to head office. The steps to do this are the same as cross checking a ledger you just need to select the create batch instead of the cross check batch. Transmission files are stored in C:\FinApp\Data\.

Transmission filenames have the following format V$UUUUPP.YY where:

V = Version
UUUU = Unit number
PP = Period
YY = Year

Email transmission file

Transmission files can be attached to emails in exactly the same way as Excel spreadsheets and Word documents. Transmission files should be sent to Guy Phillips (guy.phillips@ABC.co.uk).

Batches

Batch
Description

Calculate (Actuals)
Calculates all schedules. This is useful if you change a numbers on a schedule and want to update all other schedules e.g. if you change revenue on M1299, M2220 and M2299 will be updated.

Cross check (Actuals)
Runs the Calculate batch and cross checks all actual schedules. Errors are stored in XCheck01.rpt, which is displayed automatically. This batch does not create transmission files.

Create transmission file (Actuals)
Runs the Calculate and Cross check batches and creates a transmission file if there are no errors.

Submitting budgets

Overview

Budgets can be submitted manually in the same ways as actuals. The only difference being the template used. See the Submitting actuals section for more information.

Budget templates

Template
Description

L-BNNNN
There are no ledger templates for budget data as columns are used for months.

U-B1099 Profit and Loss (Share JVs)
U-B1220 Profit and Loss Sale of Group Companies
U-B1299 Profit and Loss
U-B2220 Balance Sheet Movements
U-B2299 Balance Sheet
U-B3210 Cash Flow Adjustments
The U prefix indicates these templates input data to individual reporting units. They will be useful if you need to input data into a single unit or into a schedule which does not have an L view.

Excel workbooks

It is also possible to import budgets from Excel workbooks. This is done using the import See the Excel import add-in section for details of how to do this.

To simplify importing Excel workbooks a mapping this process a budget import mapping workbook has 

Excel import add-in

Overview

This add-in was developed to overcome the lack of a simple method of importing spreadsheets into Comshare FDC. The add-in works with MS Excel 7.0 and above and allows quick and easy importing of Excel workbooks directly into Comshare FDC without using general ledger import. It could also be used to import any other data, which has a consistent layout, and a file format that can be opened by Excel.

The add-in can import data from workbooks into Standard schedules. It cannot import data into Category or Line Item Detail schedules, though this functionality could be added. The layout of the spreadsheet to be imported can be completely different from the layout of the FDC schedules. However, there are some restriction on the data which can be imported. These are:

· the spreadsheets to be imported must be consistent, that is the same data must appear in the same cell in every spreadsheet; 

· each spreadsheet can only contains data for one FDC unit; and 

· the import workbook filenames must be Long Unit IDs. 

The add-in has two wizards. One guides you through the process of creating a workbook to map your spreadsheets to FDC schedules and the second to import data from workbooks. These Wizards are explained below.

Starting Import add-in

To start the import add-in:

1. Start Excel Consolidation Site. From the Windows Start menu select Programs | Comshare FDC | Excel Consolidation Site. This will be Excel Control Site if you are at head office or Excel Reporting Site if you have reporting software.

2. Log in to Comshare FDC. At consolidation and reporting sites the user id is Comshare and the password is FDC.

3. Open Import.xla. In Excel Consolidation Site on the File menu select Open, select C:\FinApp\Data\FDCUser\Import.xla and click Open.

Creating a mapping workbook

This wizard creates an Excel workbook to map the layout of the spreadsheets you want to import to the layout of your FDC schedules. The steps in the wizard are:

1. Start the Import program. In Excel on the Prepare menu select Import Workbooks….

2. Select 

3. Select an example of the spreadsheets you want to import.

4. Select the sheets you want to import from the spreadsheets. These sheets will be copied into the mapping workbook and must exist in all the spreadsheets you want to import.

5. Select the schedules you want to import data to. The layout of these schedules will be automatically pasted on to a sheet named Schedules in the mapping workbook.

6. Select the period and year you want to import data to. These are recorded in a range named Definition on a sheet named Definitions in the mapping workbook.

7. The information in this range tells the add-in what data to import when the import data wizard is run. If you want to import data to several periods you will need to manually amend the Definition range.

8. Enter a name for the mapping workbook or click Browse and select an existing file. Once this step is completed a mapping workbook will be created and opened in Excel. You must then map the layout of the sheet(s) to be imported to the layout of the schedules on the Schedules sheet using normal Excel formulas. Once you have saved this revised file you are ready to import spreadsheet data to FDC.

Importing data

This wizard lets you import data into Comshare FDC from spreadsheets. The steps in the wizard are:

1. Select the mapping workbook you want to use.

2. Select the spreadsheets you want to import. You may select as many or as few spreadsheets as you want. After this step is completed the spreadsheets are automatically opened and the data imported into FDC. Importing data takes about a second per schedule per period. Therefore importing 10 schedules for 20 units for 12 months would take about 40 minutes.

Group Accounting

This section described the best way of accounting for various entities and transactions.

Joint Ventures

Each joint venture should have its own unit joint ventures should not be accounted for in the same unit as their parent company. This makes it easier to identify the reserves and assets of joint ventures.

Installing Comshare FDC

Operating systems

These instructions have been written for Windows 95/98/Me etc. The procedure is basically the same for other operating systems Windows NT/2000 etc. However, with these operating systems you will probably not be able to install the software yourself because you do not have administrator rights. If this is the case you will need to get your system administrator to perform the installation.

Remove existing software and data

To eliminate any configuration problems and ensure Comshare FDC is installed in the same way through out ABC existing Comshare FDC software and data should be deleted. The process to achieve this is described below.

Remove existing software

· Run the Uninstall Financial Apps program. From the Windows Start menu select Programs > Comshare FDC > Uninstall Financial Apps. This program group may have a different name e.g. FDC 5.0.1.3.

Removing existing data and configuration

· Delete the FinApp folder and all its contents. This will normally be C:\FinApp but the folder may have a different name. Try searching for FinApp* with Windows Explorer if you are not sure where it is. If you are not sure about what to delete please call [person] at [place].

· Delete WinFDC.ini. This will normally be in C:\Windows\WinFDC.ini.

Install software

Comshare FDC software must be installed locally and not on the network. The steps to install it are:

1. Close all Windows programs.

2. Insert the Comshare FDC CD into the CD drive on your computer.

3. Run the D:\Consolidation\Setup.exe. From the Windows Start menu select Run. Click Browse in the Run dialog and select D:\Consolidation\Setup.exe and click Open in the Browse box. Then Click OK in the Run box. If you CD drive is not D: change D: to the appropriate drive.

4. Click Next to confirm you have closed all Windows programs.

5. Click Next to confirm the directory containing Excel.exe. This directory is automatically detected and should not need to be changed.

6. Click Next to install the Btrieve Workstation Engine. This should never be changed.

7. Click Next to confirm a Typical setup.

8. Check the Destination Directory is C:\FinApp. If it not click Cancel and Exit Setup. Go back to the Remove existing data section and check WinFDC.ini has been deleted.

9. Check the Current Settings are the same as those shown below. If there are any differences make sure you understand them. Click Copy to install Comshare FDC software.

Current Settings

Target Directory:
    C:\FINAPP

Creating a Database as follows:
    Name:  DATA
    Data Directory:  C:\FINAPP\DATA
    FDC User Directory:  C:\FINAPP\DATA\FDCUSER

Program Folder:
    Comshare FDC

Setup type:
    TYPICAL
        Core Files
        Consolidation Files
            Consolidation Core
            Consolidation Db
            Consolidation Help
        DB Maintenance
            English Support
        Workstation Files
            English Support

Mapping a network drive

The Comshare FDC database is in \\scors002\scpdata\Finance\#Shared\FinApp5\Build. Before you can access it you need to map this to a network drive on your PC. To do this:

1. Start Windows Explorer.

2. From the Tools menu select Map Network Drive.

3. Select Drive U:. If U is already in use try V, X, Y and then Z.

4. In Folder type \\scors002\scpdata\Finance\#Shared.

5. Click Finish.

Linking to database

The following steps will create a link to the Comshare FDC database on the network drive you created above:

1. From the Start menu select Programs > Comshare FDC > DB Maintenance.

2. In Data Directory enter U:\FinApp5\Data and Click Next.

3. Click Copy and then Finish.

Install Reports

The following steps will copy standard reports from the server at [place] to your PC. This will mean you can open them quicker and will reduce network traffic:

1. []

Checking data

Use the standard Excel reports in C:\FinApp\Reports to check your actual and budget data. Please report any errors you find to [person] at [place].
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